


After the completion of this chapter, the

learner

• explains the process of  publishing.
• identifies the different types of

publishing.
• identifies the stages in publishing.
• uses the elements of design while

designing a page.
• applies principles of design while

designing a page.
• identifies the need for creating a

proof.
• explains the need of plates for

printing.
• explains the different types of

printing processes.
• explains electronic publishing.
• identifies the different types of

electronic publishing.
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ny new idea, story, poem, news, etc. has
to be distributed for it to be useful for
the society. Information like those

discussed above can be distributed in the society
only by publishing it. Previously, publishing was
done only by printing and distributing it.  Today,
the popularity of Internet and devices like e-
book readers which are built for reading
electronic books increased the need of
publishing a work electronically. Books,
newspapers, magazines, etc. whether it is in print
or through electronic media should be
presented in an attractive manner so that it
invites the attention of  the reader. The page
design principles, page setting, placement of
images, etc. improves the readability of  a
document. This chapter discusses the ways in
which content can be presented attractively. The
different press related processes and post press
activities in printing are also discussed. The
recent developments in electronic publishing
like blogs, websites, etc. have changed the world
of  publishing.

1.1 Publishing

Publishing comprises of the creation,
compilation and mass reproduction of graphic
and text images thereby making information
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available to the public. Books, newspapers, notices, etc. are published to provide
information to the society.

The process of publishing dates back to 30000 BC when ancient humans drew
pictures on the walls of  the caves. Humans continued publishing as a way of
expressing themselves on various media like stones, barks of  trees, leaves, etc. Later
Egyptians and Chinese contributed to the invention of  paper and this led to a
major change in publishing history. In 1455, Johannes Gutenberg, developed a
printing machine. This printing machine was in use till the 20th century. With the
advent of  computers and advanced printing technologies, publishing of  books,
magazines, newspapers, etc. was made easy. Today publishing has transformed from
print media to Internet and digital formats.

Publishing can be classified as publishing through print media and publishing
through electronic media (electronic publishing). Publishing though print media
involves designing the document, printing and preparing it for distribution. The
quality of  document design, paper quality, paper size, type of  press used for printing,
type of  binding, etc. determines the quality of  publishing through print media. The
publication of  books, periodicals, etc. in digital format, usually on CD, DVD or as
downloadable from Internet, for subscribers or public is called publishing through
electronic media or electronic publishing. Today, electronic publishing has gained
popularity and has reached a stage where some magazines are having electronic
editions only. The acceptance of  devices like electronic book readers and facilities
in mobile phones to read books, prompted publishers to publish electronic versions
of  their print editions.

1.2 Publishing through print media

Publishing a work in print can be in the form of  advertisement, poster, brochure,
books, packaging, newspaper, magazine, etc. Publishing process starts when the
editor edits content for publishing. Once the content is ready, it is considered to be

Johannes Gutenberg was a German inventor who

developed a method of printing from a movable type.

In those times, the types (characters or letters) for

printing were carved from wood. Gutenberg

developed a metal type instead of wooden types for his press.

Gutenberg's innovation of developing metal types using special

alloys made production easier. He printed the first book, 'The

Bible', which had only forty two lines, using his printing press. Johannes Gutenberg
1398 - 1468
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in production stage. The activities in production stage are classified as prepress
jobs, printing and post press jobs. Prepress is the process of  making the document
ready for printing. Printing is the stage where the actual printing happens inside a
press. Post press jobs include binding, cutting, etc. after which the document is in
the finished stage. Fig. 1.1 shows the stages in publishing through print media. We
will now discuss the different stages in publishing through print media.

Fig. 1.1 : Stages in publishing through print media
Prepress Printing Post press

1.2.1 Prepress

Prepress is the stage of work that happens between the designing of the page layout
up to sending the book for printing in the press. Prepress is an important stage
where the visual impact of the presentation is decided. While deciding the layout
of a page, the size of book or magazine is an important factor to be considered.
After finalising the layout of a page, the text and image content in the publication is
added to the page layout.

Today, there are several Desktop Publishing (DTP) softwares available that make
this process easy. Desktop Publishing is the creation of  page layouts for documents
using DTP software. Some of  the popular DTP software are Scribus, Adobe
InDesign, QuarkXPress, etc.

A. Designing

You might have noticed while browsing through books in a library or a book shop,
some books catch our eye. They prompt us to read through some pages of the
book. This is mostly due to the design of the book. The design of a book has an
impact on the readability and success of the published material. Therefore, more
attention is given by DTP operators while designing a page. Page layout design
deals with the arrangement of visual elements in a page. It involves the specific
communication objectives of the book. Some of the elements and principles of
design that creates an impact on the reader of the publication are given below:
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Elements of design

i. Line : Lines are useful for
dividing space and drawing the eye
to a specific location. Artists use
lines to create edges, outlines of
objects, etc. A line is created by
the movement of the artist's pen.
The direction of a line can convey mood. Horizontal lines are calm and quiet, vertical
lines suggest movement, while diagonal lines strongly suggest movement and give
more of  a feeling of  energy to a picture. The lines in Figure 1.2 show the moods
reflected by the lines.

ii. Shape : Shapes, geometric or organic, add
interest. Shapes are defined by boundaries,
such as lines or colour. They are often used to
emphasize a portion of the page. Shapes have
two dimensions, length and width. They can
also be geometric or free-form. A good
designer must think in terms of  how the
various elements of a design are creating
shapes, and how those shapes are interacting.
Figure 1.3 shows the different shapes and their effect.

iii. Colours : Colour is one of the most noticeable
elements of a design. It can stand alone, as a background,
or can be applied to other elements, like lines, shapes,
textures or typography. Colour creates a mood. Every
colour says something different, and combinations can alter
that impression further. Figure 1.4 shows the different
colours.

iv. Space : White space is the area in a document
where there is no text or graphics. When used
effectively, white space can be used to guide the
reader's eyes exactly where you want them to go. Space
is also a three dimensional volume that can be empty
or filled with objects. It has width, height and depth.
Space that appears in a two dimensional painting
creates an illusion of three dimension and a feeling
of  actual depth. Various techniques can be used to show such visual depth or space.
Figure 1.5 shows a feeling of three dimension and depth.

Fig. 1.2 : Design using line

Fig. 1.3 : Different shapes

Fig. 1.4 : Colours

Fig. 1.5 : Space creates depth
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v. Typography : One of  the most important
parts of  design is typography. Typography is
the art and technique of arranging type (letters)
to make written language readable and beautiful.
The arrangement of type involves selecting
typefaces, point size, line length, line-spacing,
letter-spacing and adjusting the space within
letters pairs. The fonts used tell the readers about
the seriousness of  the publication. Words are
important, but the style of the words is equally essential. Generally fonts are classified
into two styles: Sans Serif and Serif. Sans Serif is a style of fonts 'without feet'.
Common Sans Serif  typefaces include Arial, Tahoma and Verdana. Serif  style of
fonts have a 'little feet.' Common Serif fonts include Times Roman, Garamond and
Palatino. The visual difference between the two styles is shown in Figure 1.6.

Principles of design

Principles are concepts used to organise or arrange the elements of design. The
way in which these principles are applied affects the expressive content, or the message
of the work. The principles of design are balance, proportion, rhythm, emphasis
and unity.

i. Balance : Balance is the distribution of  the visual weight of  objects, colours,
texture and space. In visual images, balance is formal when both sides are
symmetrically arranged. Balance is informal when sides are not exactly symmetrical,
but the resulting image is still balanced. Informal balance is more dynamic than
formal balance and normally keeps the learner's attention focused on the visual
message. Figure 1.7a shows formal balance and Figure 1.7b shows informal balance.

Fig. 1.6 : The different font styles

Fig. 1.7a : Formal balance Fig. 1.7b : Informal balance

ii. Repetition : Repetitive works with a pattern makes the artwork look active. The
repetition of elements of design creates unity within the artwork. Repetition with
variation is interesting, without variation repetition can become monotonous. If
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you wish to create interest towards the document, the repeating element should
include a degree of variation. Repetition can also give a work a sense of motion.
Figure 1.8a shows a repetitive work without variation and Figure 1.8b displays a
repetitive work with variation.

iii. Contrast : Contrast is the association of  opposing elements like opposite colours,
tone, direction, etc.  It can be contrast in the colour wheel where opposites like red
and green, blue and orange, etc. are used (Shown in Figure 1.9a). Contrast in tone
can be light and dark (Shown in Figure 1.9b). Contrast in direction can be horizontal
and vertical. The major contrast in a painting should be located at the center of
interest. Too much contrast scattered throughout a painting can destroy unity and
make a work difficult to look at. Contrast allows us to highlight key elements in our
design. Contrast focuses on making items stand out by emphasizing differences in
size, colour, direction and other characteristics.

Fig. 1.8a : Repetition without
variation

Fig. 1.8b : Repetition with variation

Fig. 1.9a : Colour contrast Fig. 1.9b : Tone contrast
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iv. Harmony : Harmony is the visually satisfying effect of  combining similar, related
elements. The combination of  adjacent colours on the colour wheel, similar shapes,
related textures, etc. Harmony in visual design means all parts of  the visual image
relate to and complement each other. Harmony of  colours and shapes are displayed
in Figure 1.10a and 1.10b respectively.

Fig. 1.10a : Harmony of colours Fig. 1.10b : Harmony of shapes

v. Unity : Relating the design elements to
the idea being expressed strengthens unity.
A design on active aggressive subject
would work better with diagonal
direction, course, rough texture, angular
lines, etc. as shown in Figure 1.11. A design
on quiet passive subject would be better
if  horizontal lines, soft texture and less
tonal contrast are used. Unity in a painting also refers to the visual linking of various
elements of the work.

vi. Dominance : Dominance raises interest,
reducing confusion and monotony. Dominance
can be applied to one or more of the elements to
give emphasis. A dominant element in the center
(horizontally or vertically) creates symmetry, producing a formal, static design. A
dominant element close to the edge creates an out of balance tension as shown in
Figure 1.12. The position of the dominant element (colour, shape, line, etc.) should
be used to the advantage of the topic.

Everyone involved in the creation of visual content, whether knowingly or
unknowingly, uses this collection of  tools known as the elements and principles of

Fig. 1.11 : Unity

Fig. 1.12 : Dominance
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design. An understanding of this simple set of tools opens infinite choices to them.
The designers can make use of these tools to make their designs look right.

Once the page layout and design is set, the entire material is reviewed for
modifications. The correction cycle includes processes such as proof  reading and
image retouching. This is continued until no further modifications are required.

Design a poster in a chart paper for saving trees. Apply the design principles and
use the elements of design effectively to convey the message.

Know your progress

1. What is publishing?

2. The different classifications of printing are _______ and
_______.

3. What are the three activities in the production stage of publishing
through print media?

4. State whether true or false.

a. Prepress is the process of making the document ready for
printing.

b. Page designing is done during the post press stage.

5. Choose the odd one out.

a. line b. typography c. balance d. colours

6. Expansion of DTP is _______.

7. What do you mean by unity in design?

B. Pre-flighting

Once the graphics file has been created by the designer, it undergoes the next pre-
press stage called pre-flight. In this stage, the file is checked to make sure it contains
all the elements necessary for a successful printing.

The file is checked to make sure the images have the proper format and resolution,
all the fonts are included and CMYK colours are set up appropriately. We have
discussed the use of CMYK in Chapter 7 of Class XI.

You might have noticed the mark shown in Figure 1.13a in the corners of  books.
This is called crop marks. Crop marks (trim marks) are lines printed in the corners
of  the page to show the printer where to trim the paper. The layout elements such
as margins, crop marks and bleeds are also checked to make sure that it is set up
correctly. Bleed refers to printing that goes beyond the edge of  the sheet before
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trimming. It is the bleed area
that is to be trimmed off. A
margin is the area between the
main content of a page and the
page edges. The margin helps to
define where a line of text
begins and ends. Crop marks,
bleed and margin are displayed
in Figure 1.13b.

Depending on the software used to create the graphics file, sometimes the entire
file needs to be converted to a format better suited for commercial printing. The
most popular format that is supported by most printers is Adobe PDF (Portable
Document Format).

C. Creating a proof

In this stage, a proof is prepared, which will be a representation of how the finished
piece will appear when it is printed.

In the case of  business cards or postcards, a proof  is often created as a PDF. Since
a PDF is an electronic file, it can be e-mailed to the client for approval. But, if the
process involves finishing operations such as binding or folding, like that of a book
or brochure, it is recommended that a physical proof be created. A physical proof
will demonstrate how the piece will be constructed, where it will be folded, the
order of  the pages, etc.

In addition to avoiding any unforeseen errors, the purpose of  the proof  stage is to
ensure that the printed material is of the quality required.

D. Printing plates

After the proof has been approved, the
project is ready to be produced on a
printing press. If  the project is to be
produced on a digital printing press,
printing of plates is not required. This is
because the graphics file can be
electronically transferred directly to the
digital press for output.

However, if the project is to be produced
on an offset press, it will need printing

Fig. 1.14 : Plate prepared  for offset press

Fig. 1.13a : Crop
mark

Fig. 1.13b : 1-Crop marks, 2-
Bleed, 3-Margin
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plates. In this case, the final stage of  the pre-press process is the creation of  printing
plates. Printing plates are made for each job and they provide the method for
transferring the inked images to the proper place on the paper. The size of  a plate
depends on the press. Each plate can be used to print a number of  pages, depending
on the size of the page to be printed. The plates fixed on an offset press are shown
in Figure 1.14.

In the case of colour printing, separate plates are to be prepared for the four colour
components cyan, magenta, yellow and black, known as CMYK. For this, colour
separation of the project has to be done. Colour separation is the process by which
original artwork is separated into individual colour components for printing. By
combining CMYK colours, a wide spectrum of  colours can be produced on the
printed page. When the colours are combined on paper, the human eye combines
these colours to see the final image.

1.2.2 Printing

Once the prepress jobs are over, the project is ready for the next stage - printing.
Here the finished file/plate is given to the press for printing. The printing process
can be lithography, digital, gravure, flexography and screen printing. We will discuss
the different printing processes in detail below.

A. Lithographic printing

Lithography is an offset printing technique using
plates. In offset printing, ink is applied to the
printing plate to form an image to be printed. It is
then transferred or offset to a rubber blanket. The
image on the blanket is then transferred to the paper
to produce the printed product. The lithographic
process for printing is based on the repulsion of
oil and water. Lithographic printing is popular for
commercial printing of  newspapers, books, forms,
etc. An offset press is shown in Figure 1.15.

B. Digital printing

Digital printing refers to methods of printing from a digital image directly to a
variety of media. In this type of printing plates are not used. Digital printing can be
done using large format, high volume laser or inkjet printers. Digital printing has a
higher cost per page than more traditional offset printing methods. But this price is
usually offset by avoiding the cost of all the technical steps required to make printing
plates. It also supports the modification of  the image (pages to be printed) anytime,

Fig. 1.15 : Offset press
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which is not possible in offset printing once the
plates are made. It also allows on-demand
printing, where a book is printed only when an
order is received. A digital press is shown in Figure
1.16.

C. Gravure printing

Gravure or rotogravure printing is used in flexible
packaging printing process. It can be used to print
on materials including polyester, nylon, polyethylene, aluminium foils and paper.
The cylinder of the gravure printer is engraved with the image to be printed. The
cylinder is immersed in ink and its engraved cells store the ink which is transferred
to the material to be printed. Its features are good quality image reproduction and
low cost per unit on high volume production. Rotogravure printing is a suitable
choice to print on laminated packaging for different ingredients. Figure 1.17a shows
a rotogravure press and Figure 1.17b shows printing samples.

Fig. 1.16 : Digital press

Fig. 1.17a : Rotogravure press Fig. 1.17b : Gravure printing samples

Fig. 1.18 : Flexographic press

D. Flexography

Flexographic presses are capable of
producing good quality printing on many
different materials. It is considered as the
least expensive and simplest of the printing
processes used for printing on packing
material. Flexography has a relatively simple
operation, similar to the use of  a rubber seal
and ink stamp pad. The image to be printed
is prepared on flexographic plates made of
a flexible material, such as plastic, rubber,
etc.  This plate is then inked and then it is
transferred to printing material. Compared
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to offset and gravure, its ink dries faster which results in faster production, thereby
lowering costs. Due to this the use of  flexographic printing presses is on the rise.
Flexography is used for the production of  shopping bags, flexible plastics for milk
and other food packets, self-adhesive labels, disposable cups and containers,
envelopes and wallpaper.

E. Screen printing

Screen printing is a simple
process for printing. It is a
printing technique that uses a
woven mesh to support an ink
blocking stencil to receive a
desired image. A rubber blade
is moved across the screen
stencil which forces the ink
through the mesh openings on
to the print surface. Screen
printing has to be done on a flat
surface and the area being printed should not be under pressure. It can be used to
print on a wide variety of  materials, including paper, plastics, glass, metals, fabrics
and others. A screen printing process is displayed in Figure 1.19.

1.2.3 Post press

Post press is the final stage in the printing process. It involves all the cosmetic or
functional changes that are done on the final print. The four major operations in
post press are folding, assembling, binding and cutting. There are many additional
post press finishing processes such as varnishing, laminating, embossing, perforating,
drilling, etc. that improves the appearance or functionality of the printed material.

A. Folding

Usually in a printing press, several pages
are printed on both sides of a large paper
and then they are folded according to an
imposition scheme. Imposition scheme is
the arrangement of pages for printing in
such a way that when the sheet is folded,
the pages will be in the correct order. The folding process can be according to
various imposition schemes. A sample layout of  the pages after printing is given in
Figure 1.20. Page numbers are specified in the figure. This sheet has to be folded

Fig. 1.19 : Screen printing

Fig. 1.20 : Folding scheme for 16 pages
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according to a scheme so that the pages are in serial order. A folding machine can
automatically fold any type of paper according to the imposition scheme for
notebooks, textbooks, magazines, brochures, etc.

B. Assembling

The assembling/gathering is the process that brings all the printed pages of the
final product together in the required order according to the binding style. Assembly
processes can be manual, semiautomatic or fully automatic. Manual and
semiautomatic assembling requires the attention of  a worker. Fully automatic
assemblers are kept in line with the binding machines in order to improve efficiency.

C. Binding

Book binding is the process of physically assembling a book from a number of
folded or unfolded sheets of paper or other material. The type of binding is usually
selected based on the function of the document, the number of pages it contains
and the printing budget. Some of the popular binding techniques are hard cover
binding, punch and binding (spiral binding), thermally activated binding, stitched
binding, etc. Some of the types of binding are given
in Figure 1.21.

D. Cutting

Cutting is done according to the crop marks printed
on the paper. Cutting can be either done manually
or using a machine. A cutting machine cuts the
stacked printed pages. The cutting blade is powered
electrically. Though cutting is generally considered
a postpress operation, most lithographic and
gravure presses have integrated cutters as well as

Fig. 1.21 : Different types of binding

Fig. 1.22 : Cutting machine
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Calico is an all-cotton plain woven fabric printed with simple designs in

one or more colours. Calico originated in Calicut, India, by the 11th century.

Calico cloth was used for binding books. This style of binding was popular

as calico binding. This process involved stiching, gluing and then coving

the area to be binded using calico cloth. In the 17th and 18th centuries calicoes were

an important commodity traded between India and Europe.

Job Definition Format (JDF) is a printing industry standard designed to

simplify information exchange between different programs and printing

systems. It is managed by the industry association CIP4 (International

Cooperation for the Integration of Processes in Prepress, Press and

Postpress Organization). It manages the print, packaging and label work (job) flows.

JDF starts a job ticket with an 'intent' for the job. More JDF details are added later

in various steps of the production workflow. A JDF ticket contains information that

enables each node to determine what files it needs as input, where they are found and

what processes it should perform. After executing a task, it modifies the JDF job

ticket to describe what it has done and examines the JDF ticket to determine where

accompanying files and instructions should be sent next.

Know your progress

1. What is pre-flighting?

2. The expansion of pdf is ____________.

3. What is the purpose of  creating a proof?

4. State whether true or false.

a. The lines printed in the corners of the page to show the
printer where to trim the paper is called margin.

b. Bleed refers to printing that goes beyond the edge of the
sheet before trimming.

5. Name the printing technology that can be used to print on nylon.

a. Gravure b. Digital c. Offset d. Screen

6. List the different types of  binding.

7. What is lithography?

equipment to perform related operations like perforating. Perforation is a small
hole or a row of small holes punched in a sheet of paper so that paper can be easily
torn through this. Figure 1.22 displays a cutting machine.
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1.3 Electronic publishing

You might have noticed people watching movies, enjoying songs, reading books,
etc. in their mobile devices like mobile phones, tablets, laptops, etc. while travelling.
Today more and more people are forced to spend time for travel regularly due to
many reasons like work, visiting relatives, etc. They wish to utilise their time fruitfully
by reading books, listening to music, etc. This has compelled the publishing
companies to release electronic versions of  their publications. These publications
can be bought online and people can read them using their mobile devices.

Electronic publishing is the digital publication of  e-books, digital magazines and
the development of  digital libraries and catalogues. Electronic publishing takes the
format of  works published online, on a compact disk, e-mailed or provided in a
file format compatible with handheld electronic readers. It is also called e-publishing
or digital publishing.

Electronic publishing can be either web based publishing or as digital distribution
of  content. In web based publishing, information is published in websites. We can
browse and use the website to read the material. Websites like www.wikipedia.org
publish content over their websites. In the case of  digital distribution publishing,
the material can be downloaded from a website and can be read using an electronic
reading device like mobile phone or e-book reader. Many publishers now publish
their books electronically in downloadable format.

The effective use of elements of design improves the appearance of content in
elctronic publishing. Principles of  design can also be used to enhance the design of
pages.

1.3.1 Web based publishing

Web publishing or online publishing is
the process of publishing content on
the Internet. It includes creating and
uploading websites, updating
webpages, and posting blogs online.
The published content may include text,
images, videos, and other types of
media. Websites like Wikipedia, online
newspapers, blogs, etc. are examples of  web based publishing.

Web based publishing requires an Internet connection to read the material. This
material is available on any device that has an Internet connection. Web based
publishing are mostly freely available on Internet.

Fig. 1.23 : Web based publishing
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To develop a website for publishing content, we require a web development tool
like, HTML (Hypertext Markup Language), CSS (Cascading Style Sheet),  JavaScript,
PHP, etc. The site thus developed has to be uploaded to a web server, called web
hosting. We will discuss HTML, CSS and the technologies for uploading web sites
to a web server in detail in the forthcoming chapters. Publishing through blogs
does not require much knowledge about the web based technologies. This can be
done easily using the user friendly features provided by the popular blogging services
like blogger.com, wordpress.com, etc.

Since web publishing does not require physical materials such as paper and ink, the
cost of  publishing content on the web is almost nothing. Therefore, anyone with
basic knowledge of  Internet can be a web publisher. It has a vast audience since
content posted on the web can be viewed by anyone in the world with an Internet
connection. These advantages of web publishing have led to a new era of publishing
that was not possible before. Figure 1.23 displays websites and blogs in various
devices.

1.3.2 Digital distribution

The electronically published materials like e-books, e-journals, etc. can be downloaded
from various websites. This type of  publishing is called digital distribution. Book
publishing companies sell the e-book versions of their hard bound publications
through the various e-commerce websites. Users can download any number of
these e-books from these websites to their mobile devices and can read them when
required.

Barnes & Noble - Nook Apple-  iPad
Fig. 1.24 : Popular e-book readers

Amazon - Kindle

An e-book reader is a mobile electronic device that is designed for reading e-books
and digital periodicals. An e-book reader is similar in form, but more limited in
purpose than a tablet. In e-book readers, the light in the screen is from above,
whereas in the case of  mobile phones, tablets and laptops the light from the screen
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is backlit. The backlit screen causes fatigue, if  used for reading for long hours. The
front lit screens in the e-book readers provide a better reading experience. In
comparison to tablets, many e-book readers are better than tablets for reading
because they are more portable, have better readability in sunlight and have longer
battery life. The popular e-book readers are Amazon Kindle, Barnes & Noble Nook,
Apple iPad, etc. Some of  the popular e-book readers are displayed in Figure 1.24.

Electronically published materials can be developed using the same DTP software
used for print based publishing. The process of  publishing the material in the
prepress stage of  print based publishing is the same here too. The material to be
published is then converted to a format readable by the e-book readers. The popular
e-book formats are PDF, iBook, Kindle, etc.

PDF (Portable Document Format) was developed by Adobe Systems and first
released in 1993. This format was developed to provide a platform independent
means of  exchanging documents. PDF documents can be read using a wide variety
of  readers freely available like Adobe Reader, Open Office.org, Nitro PDF, etc.
PDF files are supported by almost all modern e-book readers, tablets and
smartphones. iBook is the native file format for Apple iPad and Kindle is the file
format for Amazon's Kindle book reader.

Know your progress

1. What is electronic publishing?

2. Name any two web based publishing technologies.

3. Write an example of  a popular blog for publishing.

4. What is the use of an e-book reader?

5. PDF was developed by _____________.

6. List two examples for PDF readers.

Let us conclude

Any creative work has to be published for distributing to the society. The success
of a published work depends on its appearance. Publishing can now be divided
into print based and digital publishing. Print based publishing dates back to the
years of  Johannes Gutenberg, the person who developed the first printing machine.
Today the different stages of  print based publishing like prepress, printing and
post press has been automated. Prepress work includes designing the document to
be printed. Softwares are used to design the layout of a page. This is done based on
the principles of  design and also by giving importance to the various design elements.
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The well designed material is checked for errors by creating a proof and then
transferred to plates. Once the plates or the material is ready for printing, it can be
printed using the press suitable for the material. Once printing is over, the pages
need to be cut, folded, assembled and bound to form a book. Electronic publishing
has gained importance due to the popularity of Internet. The different types of
electronic publishing are web based and downloadable format. Web based
publishing can be done through websites or through blogs. They are mostly cheap.
Downloadable e-books requires specific softwares to read. Portable e-book readers
can be used to buy and read e-book versions of popular hard bound books online.

UVW XY ZYYVYY

1. Explain the three different stages in publishing.

2. Arun plans to design a brochure for his restaurant. Name two softwares that
can be used to design the brochure.

3. Explain the elements of design.

4. In a paper advertisement, a designer has space to draw lines. Suggest a line
style that can give a feel of  energy to the brochure.

5. Classify the following fonts into serif  and sans serif  categories.

Arial, Times New Roman, Garamaond, Verdana, Palatino

6. Write short notes on contrast and balance in design principles.

7. Why are plates not used in a digital press?

8. What is the use of plates in an offset press?

9. What is colour separation?

10. Harilal is planning to publish a book. Suggest a printing process that can be
used for this purpose. Justify your suggestion.

11. Why is flexography used in mass production when compared to other printing
processes?

12. Explain how screen printing is done.

13. What do you mean by post press? List and explain the four major operations
that are done during this stage.

14. What is electronic publishing? What are the different types of electronic
publishing?

15. You have written a story in English and you wish to publish it electronically.
Which type of publishing would you prefer? Why?

16. Vimala has an e-book reader and a mobile phone with a large screen. Which
device will be better for reading while travelling? Why?
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e discussed various aspects of

publishing in the last chapter. It is

identified that pre-press activities

play an important role in print-media

publishing. This chapter introduces a type of

software called word processor that helps to

perform prepress activities when the text

material is ready. Word processor is an

application software tool or package that

processes textual matter and creates organised

and flawless documents. Document is a file

that contains text or images which was earlier

prepared using pen and paper, and typewriting

machines. Bio data, reports, write-ups,

publications, etc are examples of  documents.

Word processor not only removes all the

limitations of conventional typewriting

machines but also offers various useful and

attractive features. Many software companies

offer word processor packages. A large

community of  users like scholars, teachers,

lawyers, doctors, publishers, students, etc.

enjoy the features of  word processors. Some

of the popular examples are LibreOffice

Writer, Microsoft Word, AbiWord, etc.

After the completion of this chapter, the

learner

• recognises the use of word

processing software and its

features.

• differentiates various components

of the IDE of the word processor.

• creates documents using word

processor.

• copies or moves text from one

place to another in a document.

• searches a particular text in the

document and replaces it with

another text.

• changes the appearance and style

of text by applying the features like

bold, italic, underline, font face,

font size, etc.

• configures a paragraph of text by

changing alignment, indent, line

space, etc.

• creates lists using bullets or

numbers.

• alters the page size, orientation and

page margins.

• inserts header and footer in pages.

• takes the  hard copy of a document.
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2.1 Features of a word processor

The word processing software is developed in such a way that it helps the creation
of  a document with ease. It provides menus and tools to perform various operations
like creating documents, editing and formatting text, inserting tables and images,
etc. Let us see some of  the important characteristics of  word processors.

Quickness: Word processors help easy creation of  a new document and
manipulation of  the content. Tools are available for speedy typing, editing and
formatting in the form of  menus, icons and short-cut keys. Document files can be
saved, retrieved and printed quickly and easily.

Word wrapping: As we type the text matter towards the end of  a line, a word may
not fit completely in the line. In that case, the word going past the right margin is
placed in the next line automatically. This feature is called word wrapping.

Editing features: Editing is the process of correction like insertion or deletion of
text, copying or moving of  text, etc. We can perform these with ease using word
processors.

Drawings and graphics: Word processor provides tools for drawing various
shapes and figures. It also allows pictures or images to be inserted in documents.

Tables: Tables are provided in documents to present text or data in rows and
columns.

Formatting features: Word processor offers various types of  formatting like
character formatting, paragraph formatting and page formatting. Formatting the
content makes a document more legible and beautiful.

Header, Footer and Page number: Header is the text appearing at the top of  all
pages and footer is the text appearing at the bottom of all pages in a document.
Page numbers are continuous numbers given to each page in the document. Word
processors provide these features to manage multi pages document effectively.

Object Linking and Embedding (OLE): OLE is a program-integration
technology used to share information between programs through objects. Objects
are saved entities like images, charts, equations, files created using other software,
etc. These objects can be linked and embedded with a document.

Spell check and Grammar check: Using this feature, a word processor scans
documents to identify any spelling or grammatical error in the document. The
comparison of  the text in document is made with a standard built-in dictionary.

Mail merging: This facility helps to print many documents with same content and
addressed to different people. This is mainly used for mailing invitation letters,
notices, etc.
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Index and Table of  contents: Index is usually created at the end of  a professional
document like project report, survey report, government write-ups, etc. Index
includes important terms or words appearing in the document. Table of  Contents
appears at the beginning of a professional document or textbook, after the title
page. This contains the main headings and sub headings appearing in the document
with the respective page numbers. Both the above pages can be easily created using
the options available in word processors.

Templates: Templates are predefined document formats available with the
software. They have predesigned layouts and formats. It is easy to create a new
document from a template. We need only to enter the text at required positions.

This chapter introduces the basic formatting features of  word processing software.
The advanced features will be explained in the next chapter. Though there are several
products for word processing, we use the LibreOffice Writer for further discussions.
It is one of the components of LibreOffice integrated package, which is an open
source software. It provides all features of  a typical word processor. LibreOffice
has separate versions for both Linux OS and Windows OS.

2.2 LibreOffice Writer IDE

In the Linux Operating System, we open LibreOffice Writer using the command
sequence Applications → Office → LibreOffice Writer. The LibreOffice Writer window
will be opened as shown in Figure 2.1. This window is known as LibreOffice Writer
Integrated Development Environment (IDE) window. The main components of
the IDE window are Title bar, Menu bar, Toolbars, Ruler, Scroll bars and Text area.

Fig.2.1: LibreOffice Writer IDE window

Title Bar
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These components are similar to those seen in the opening window of LibreOffice
Calc. Let us have a look at these components.

Title bar: It is the topmost part of  the IDE window. It shows the name of  the
document and the name of the software at the left, and the control buttons (Minimize,
Maximize and Close) at the right. In Figure 2.1, we can see the text item Untitled1,
the default name of the document which can be changed when we save the document
with a user-supplied name. It is followed by the name of the software
LibreOfficeWriter. We know that on clicking the Minimize button the document
window (IDE) is minimised to a small icon and kept in the task bar, Maximise
button is used for maximising the current document window to fit the whole screen
area, and the Close button closes the software itself.

Menu bar: It contains all the important menus available with the software. They
include File, Edit, View, Insert, Format, etc. When we click on a menu item, a pull-
down menu appears with more commands associated with the menu item as options.
There may be sub-menus under certain options in the pull-down menus.

Toolbar: It contains shortcut commands in the form of  various buttons. Each button
is characterised by the presence of an icon (small pictures or symbols). If we place
the mouse pointer on a button, a short text will appear as its description called
'Tool Tip'. There are many toolbars like Standard toolbar, Formatting toolbar,
Drawing toolbar, etc. Toolbars can be managed using the View menu. Additions
and removal of toolbars are possible by selecting the required toolbar from the
list. In Figure 2.1, we can see Standard toolbar and Formatting toolbar at the top
and Drawing toolbar at the bottom.

Scroll bars: Scrolling is the process of moving up and down or left and right through
the document window. There are two scrollbars namely Vertical and Horizontal
scroll bars for scrolling the document vertically or horizontally. The Vertical scroll
bar appears at the right most part of the IDE screen. The Horizontal scroll bar
appears just above the Status bar which is at the bottom part of  the IDE window.
This scroll bar will be visible only when it is required, i.e.; when the document
window resizes to small window. We can see vertical scroll bar in Figure 2.1.

Ruler: This allows changing the left and right margins of the document. There are
two rulerbars. One is at the top and the other is at the left side. Figure 2.1 shows

I< =>?@Ae 2.1, the Title bar is marked. Similarly, identify the other
components that are detailed below and mark them in the figure.
You may refer the opening window of  LibreOffice Calc that you
learned in Class XI or run the software in the computer.LBD EF GH
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these rulers. Margin is the distance between the text and an edge of  the paper. The
ruler in the IDE window displays the positions of  margins.

Margins are mainly of four types:

1. Left Margin : The distance between the text and the left edge of  the paper.

2. Right Margin : The distance between the text and the right edge of  the paper.

3. Top Margin : The distance between the text and the top edge of  the paper.

4. Bottom Margin: The distance between the text and the bottom edge of  the paper.

Status bar: It is visible at the bottom of  the IDE window. It displays information
like page numbers, column and line number where the cursor (small vertical blinking
character) is located, the selected language etc. as shown in Figure 2.1. The page
number area usually shows the page number where the cursor waits and the total
number of  pages in the document. For example, Page 1/4 indicates that the current
position of the cursor is at page number 1 and the total number of pages in the
document is 4. Another important item on the Status bar is the zoom area which is
placed at the right most end of  the Status bar. The middle point button present in
the area can be drawn to the right (+) or to the left (-). If we drag the button to the
right (zoom out), the document window enlarges and when the button is moved
left (zoom in), the document window shrinks. This is very useful for getting a closer
view or distant view of the document. The Status bar also shows the Insert/

OverWrite status which will be discussed later.

Text area:  It is the place where we type the text matter of  the document to be
created. It is also called the document area. The cursor will be present in the text
area.

2.3 Creating a new document

We have seen that when we run the LibreOffice Writer in a computer we get a
window as shown in Figure 2.1. Actually a new document is opened and we can
input or type in the desired text in this document. If an existing document is visible
in the IDE, a new document can be opened using the command sequence File →New

→Text Document or by pressing the key combination Ctrl+N (the keys Ctrl and N).

A new document can also be open by clicking New button  in the Standard

toolbar. In such a case, the new document will be opened in a new IDE window. Let
us prepare an article for the school magazine about voluntary blood donation.
Assume that we are ready with enough material for the article. Let us type in the
text matter in the new document. Assume that the first page looks like the one as shown
in Figure 2.2.
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Fig.2.2: A document in Writer IDE window

While typing, the space bar key, tab key and Enter key, etc. may have to be used. We
can see that the text matter is aligned to the left margin. The font characteristics of
the text take the default values like Liberation Serif face, 12 point size, black colour, etc.
These are visible in the Formatting toolbar (just above the horizontal ruler) in the
window. We can see that some words are underlined in red colour. This indicates
that the word is misspelt. We can correct them by adding some letters or deleting
some other letters. There may be grammatical error also. Such corrections are part
of  editing process. We may also have to change the font characteristics of  some
text and set the margins and spacing to make the article more presentable and
attractive. These are part of  the formatting processes. We will discuss these details
in the coming sections.  Before doing these processes, it is better to save the document
with a suitable file name.

2.4 Saving a document

As mentioned in the previous section, when we open a new document for storing a
text matter, it is better to be saved frequently to avoid loss of material due to
unexpected termination of  the program. The document can be saved permanently
in the computer by selecting the command sequence File → Save or by pressing the

key combination Ctrl+S or by clicking the Save button  on the Standard toolbar.
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When we save the document for the first
time using any of  these methods, the
Save window appears as shown in
Figure 2.3. We can give a suitable name
to the file in the text box against the label
Name:. As seen in Figure 2.3, the default
name Untitled1 will be highlighted
initially, which will be replaced by the
user-supplied name. The file will be
saved with extension .odt in the current
folder. We have the freedom to place
the file in the desired folder. Let us save
the file with the name donation.odt. The
window shown in Figure 2.3 will not appear on further execution of Save command.
But, if we select the command sequence File → Save As... or press Ctrl+Shift+S

frequently, this window will appear each time and the same document has to be
saved in another name in the current folder or with the same name in another folder.
When we complete a session in the preparation of the document, it is to be closed.

Fig. 2.3: Save window of Writer

2.5 Closing a document

At the end of a session we need to close the file in which we are preparing the
document. A file can be closed by using the command sequence File → Close or by

clicking the Close button  in the Menu bar. Note that if  we click the Close

button  in the Title bar, the software LibreOffice Writer will be closed along

with the file(s) in use. Before closing a document, it is always better to save the latest
changes in the file. In case if we have not saved the document with the latest version,
the Writer will prompt us with a dialog box with three options namely, Close without

saving, Cancel and Save as shown
in Figure 2.4. One of those
buttons can be selected. If we
select the Save button, the Save
dialog box will appear if it is the
first time saving, otherwise the file
will be saved with the latest

ijklmk l nopqrksm mo tjktljk ls luuvwsrksm tltkj os xysz{qkspk oz

the Visual Media on Students". Initially you collect sufficient material
and start typing into the document, and save it in a file. Don’t bother
about the format, layout, mistakes and such things for the time being.|}~ �� ��

Fig. 2.4: Save document? window
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changes in the current file name. If we click the Close without saving button, the file
will be closed without saving the changes after the last save. On clicking the Cancel

button the dialog box will disappear and the document will remain in the edit mode
itself.

The final step of  every Writer session is to come out of  the software. It can be done
with the command sequence File → Exit LibreOffice or using the keyboard shortcut
Ctrl+Q. It is also possible with a click on the the Close button in the Title bar as
mentioned earlier.

2.6 Opening a document

Suppose we want to see the content of a file or make some modifications in the
form of  adding more data, deleting some existing content or replacing some current
portion with new material. Whatever be the intention, the file is to be opened first.
This can be done with the command sequence File → Open or with the shortcut

keys Ctrl+O. It is also possible with a click on the Open button    in the Standard

toolbar. Now a dialog box appears as shown in Figure 2.5. Choose the required file

from those visible in the

window. If  the file is not found

in the opened folder, find the

folder first from the Places list

box in the window. Once the

file is selected, click the Open

button in the window. Double

click on the file will also do the

same. The file will be displayed

on the screen.

2.7 Editing a document

Editing is a process of bringing about changes in a document. It may include copying,

moving, finding, replacing, deleting, and inserting text or graphics. This process

may require navigation through the document. Let us see the common activities

during document editing.

2.7.1 Prerequisites for editing

Before editing a document we may need to perform some operations like navigation,

Insert/OverWrite mode setting, selection of  text, etc. Let us familiarise ourselves

with these operations.

Fig. 2.5: Open dialog box
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A. Navigation

Moving froma point to another in a document is normally called navigation. While
editing a document, to make changes at a particular location, the cursor is to be
placed at that place. The following keys facilitate navigation:

Arrow keys: To move the cursor to the very next character (to the left or right, or
at the previous or next line).

Home: To move the cursor to the beginning of  the current line.

End: To move the cursor to the end of  the current line.

Page Up: To place the cursor after moving one screen full of  content upwards from
the current position.

Page Down: To place the cursor after moving one screen full of  content downwards
from the current position.

Ctrl+→→→→→: To move the cursor to the beginning of  the previous word.

Ctrl+←←←←←: To move the cursor to the beginning of  the next word.

Ctrl+Home: To move the cursor to the beginning of  the document.

Ctrl+End: To move the cursor to the end of  the document.

Navigation can also be performed by scrolling the mouse. The document can be
scrolled upwards or downwards by keeping the mouse pointer anywhere in the
document and rolling the scroll wheel on the mouse. The same effect can also be
achieved by dragging the scroll button on the scroll bars in the window or clicking
on the up and down scroll arrows. In Figure 2.1, you might have identified a vertical
scroll bar. Though it is not present in this figure, there is a horizontal toolbar at the
bottom of  window.

B. Insert/OverWrite mode setting

The Status bar at the bottom of  the IDE window shows this setting. If  we can see a
blank box to the right of  Language status display, we will say that the document is
in Insert mode. This mode allows insertion of a new character in the document
without losing the existing information. If  we press the Insert key in the keyboard,
the status will change to OverWrite mode which we can see in the Status bar. In this
mode, a new character will replace the existing one. Insert key is a toggle type key.
By default the mode is Insert mode. When we insert a new text in the Insert mode,
the existing matter will be shifted to the right to accommodate the new text. Addition
of  new text in a document and replacing existing content by new information are
all part of  editing.
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C. Undo and Redo actions

Writer provides two special buttons Undo and Redo . We can use Undo

for undoing or cancelling the most recent actions. However, if  we want to retrieve
an action cancelled by Undo we can use Redo button. The Undo and Redo actions
can also be performed by the keyboard shortcuts Ctrl+Z and Ctrl+Y, respectively.

D. Text selection

While working with a document, we may have to perform some operations on a
block of text. A word, phrase, sentence, paragraph or even the entire document
can be a block of text. The block of text is to be marked or selected prior to
perform any edit operation. This is called text selection, which is mostly done in
two ways as follows:

Using mouse: Place the cursor at the starting position of the text to be selected.
Hold down the left mouse button and drag slowly till the end of the text is selected.

Using keyboard: Place the cursor at the starting position of the text to be selected.
Hold down the Shift key and press the proper navigation keys until the required
text matter is selected.

The selected text will appear
in a shaded area with a slight
colouration. If we want to
select the whole document, it
can easily be done with the
keyboard shortcut Ctrl+A, or
using the command sequence
Edit → Select All. After
selecting the text, if we click
anywhere in the document
area, the selection will be lost.
Figure 2.6 shows a selection
in the document we are
creating.

2.7.2 Cut, Copy, and Paste functions

These are the functions used frequently in editing.
Commands, keyboard shortcuts and button are available
to perform these functions. Figure 2.7 shows these
buttons seen in the Standard toolbar.

Fig. 2.6: Text selection

Fig. 2.7: Cut, Copy, Paste
buttons
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While preparing the document or at a later stage we may find that some text is at an
improper location in the document. We may think of  deleting the content from its
current place in the document and retyping it at the new location. But Writer helps
us by providing the facility of  Cut and Paste function, by which we can move a
block of  text or any other object from one position to another. It requires the
following steps:

i. Select the text or object to be moved.

ii. Use any one of following actions for cutting:

• Select the command Cut from Edit menu.

• Right click the mouse at the selected text and select Cut from the context
menu.

• Press Ctrl+X.

• Click Cut button (refer Figure 2.7) in the Standard toolbar.

iii. Place the cursor at the position where the text/object is to be moved.

iv. Use any one of the following actions for pasting:

• Select the command Paste from Edit menu.

• Right click the mouse at the selected text and select Paste from the context
menu.

• Press Ctrl+V.

• Click Paste button (refer Figure 2.7) in the Standard toolbar.

Sometimes, a text may need to appear in different places in the document. In some
cases, a portion of  the content in one document may need to be present in another
document. If  the text is too large to type again and again, Writer gives the facility of
copy and paste. The procedure is as follows:

i. Select the text or object to be copied.

ii. Use any one of following actions for cutting:

• Select the command Copy from Edit menu.

• Right click the mouse at the selected text and select Copy from the context
menu.

• Press Ctrl+C.

• Click Copy button (refer Figure 2.7) in the Standard toolbar.

iii. Place the cursor at the position where the text/object is to be copied.

iv. Use any one of the following actions for pasting:

• Select the command Paste from Edit menu.
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• Right click the mouse at the selected text and select Paste from the context
menu.

• Press Ctrl+V.

• Click Paste button (refer Figure 2.7) in the Standard toolbar.

2.7.3 Deleting text

Deleting is the act of  removing a selected word or text matter permanently from
the document. It can be performed by any method mentioned in the previous section
for cutting the text. Alternatively, we can press the Del or Delete key in the keyboard
after the selection.

As soon as we copy or cut a selected text, it will be placed in a temporary memory
area called Clipboard. At any point of time, this matter can be pasted somewhere
before exiting from the package.

2.7.5 Find and Replace facility

While editing a document, we may need to search for a particular word or text in
the document. Sometimes, the searched text is to be replaced by some other word.
Word processor provides Find and Replace facility for this purpose. Let us see
how we can do this in Writer.

A. Finding a text

There may be one or more occurrences of the searched item. If we want to search
for a text in the document select Find option from Edit menu or use the keyboard
shortcut Ctrl+F. A floating toolbar as shown in Figure 2.8 will be opened. Here we
have to type in the search text (see the word blood in the textbox) and then click on

ÊËÌ ÍÎ ÏÐÎÌÐÑÒÍÐÎÓ ÔËÌÕeen Cut - Paste and Copy - Paste functions.
Table 2.1 contains some points. The cells left blank are intended for
you. Fill in with suitable value points.

Ö×Ø ÙÚ ÛÜ

ÝÞß à áâãßä Copy - Paste

• Does not duplicate text

• ....................................
....................................

• Moves the text from one place to
another

• ............................................

• Selected text will be present at both
the source and destination location

• ..............................................

Table. 2.1: Cut-Paste Vs Copy-Paste
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the Next or Previous button. The
very next occurrence of the search
text after or before the cursor
position will be highlighted as
shown in Figure 2.8. All the
occurrences of the search text will
be highlighted if we click Find All

button in the toolbar. Usually the
case of the text will not be
considered while searching. Case sensitivity can be enforced by clicking the check
box visible at the left of  Match Case in the Find toolbar.

B. Finding and Replacing a text

When we want to replace an existing text by a new one, we have to select Find &

Replace option from Edit menu or press Ctrl+H. The Find & Replace dialog box
will appear as shown in Figure 2.9. The dialog box provides all facilities to find the
search text in the document and
replace with the new text wherever it
is needed. In the Search for box, enter
the text to be searched. There are
mainly two checkboxes. One is the
Match case as mentioned earlier. The
other is Whole words only, which on
click will search for the text that
appear as whole words only.

In the Replace with box, enter the
replacement text. Then click the
Replace or Replace All button as per
our requirement. To cancel a search
in progress, we need to press Esc key
in the keyboard.

Fig. 2.8: Find floating tool bar

Fig. 2.9: Find & Replace dialog box

érite down the procedure to search for the word "blood" and replace
it by "Blood", whenever it appears at the beginning of a sentence.

êëì íî ïð

2.8 Formatting the document

A document can be made attractive by applying certain formatting features. The
general arrangement of  text is known as formatting. Formatting makes our

PreviousNext
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document presentable. We can make some text bigger in size, stylish in font and
beautiful in colour. Different types of  emphasis can be given by underlining,
italicising, etc. All these activities are included in the process of  formatting the
document. The whole content in the document will not be of the same importance
or at the same level. There may be headings at different levels, listing of  items,
notable content, etc. While formatting a document, we need to keep in mind all
these factors. Formatting provides documents a neater and more legible outlook.
There are various aspects of  text formatting like character formatting, paragraph
formatting and page formatting.

2.8.1 Character formatting

Character formatting plays an important role in enhancing the appearance of  a
document. It decides how individual characters in the document should appear.
Character formatting is concerned about making decisions regarding the font
characteristics such as type of  font, size and colour. The character formatting is
also associated with the setting of  text attributes like bold, italics, underline, etc.
and text positioning  like superscript,  subscript, etc. Some of the important text
attributes in character formatting and their effect are shown in Table 2.2. Word
processor offers a variety of
character formatting facilities at
the same place. Let us see the steps
for character formatting in
Writer. Before applying the
character formats, the text is to
be selected. Using the command
sequence Format → Character...,
the Character dialog box as
shown in Figure 2.10 can be
opened where the formatting
facilities are provided in different
tabs.

i. Font tab provides Family (different font faces), Style (Regular, Bold, Italic,
Bold Italic), and Size. (In Ubuntu Linux based LibreOffice Writer, fonts for English

and Malayalam languages will be visible as in Figure 2.10).

ii. Font Effects tab gives options for Font color, Effects (Capitals, Lowercase,
etc.) and Relief (Embossed and Engraved). It also provides Overlining,
Strikethrough and Underlining with different types and colours of  lines. Some
checkboxes are given for Outline, Shadow, etc.

Text attribute Effect after

applying the attribute

Bold

Italic

Strikethrough

Overlining

Underlining

Font color

Superscript

Subscript

Computer Applications

Computer Applications

Computer Applications

Computer Applications

Computer Applications

Computer Applications

A2 (2 is superscripted)

A
2
 (2 is subscripted)

Table 2.2: Text attributes
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we can see formatted text. Write down the procedure required for
this and check whether you get the same format with your procedure.
Note the position of the character + after Na and K in the last line
of  the window. Also identify the buttons in the Formatting toolbar
seen in the figure, to apply Font Style (Bold, Italic, Underline) to the
selected text.

L�� � !"

iii. Position tab facilitates superscripting, subscripting, etc. It also gives options
to rotate the selected text at an angle. Another facility available is that, the
spacing between the characters in the text can be increased (expanded) or
decreased (condensed).

iv. Hyperlink, Background and Borders are the other tabs in the dialog box.

The font style Bold, Italic and Underline can also be applied to a selected text by
the keyboard shortcuts Ctrl+B, Ctrl+I, and Ctrl+U, respectively. The key combination
Ctrl+B+I+U can make the three styles effective on the selected text.

Fig. 2.10: Character formatting dialog box

2.8.2 Copying a format

The word processor provides an easy way to copy the character formats applied to
a selected text and use the same for a particular text at another place in the document.
Suppose we have formatted a heading text with some font characteristics and font
style. The same can be easily copied and apply to another text in the same document

using the Format Paintbrush button  in the Standard toolbar. The procedure is

as follows:
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• Select the text from where the format is to be copied.

• Click the Format Paintbrush button.

• Click the text or paragraph where the format is to be applied.

Fig. 2.11: The document after some character formatting

Know your progress

1. State whether the following statements are True or False:

a. Writer automatically wraps the text extending beyond the right
margin to the next line.

b. Ctrl+S is the short cut key combination to select a text in Writer.

c. Copy/Cut/Paste buttons are present in the Standard toolbar.

d. Writer does not offer a facility to cancel the most recent actions.

e. A text entered in Writer can be rotated to 900.

2. Fill in the blanks

a. The Bold button is present in ______ toolbar.

b. Formats applied to one text can be copied using the ______ button.

c. The text or graphics copied or cut from the document will be
temporarily placed in the memory area called ______.

d. To move a text or object from one place to another in a document,
______ and ______ operation is required. (Cut, Copy, Paste)

e. The keyboard shortcut for opening an existing file in Writer is ______.
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2.8.3 Paragraph formatting

Paragraph formatting involves controlling the appearance of  the entire text in a
paragraph. The main contents of  documents like articles, assignment papers,
textbooks, reports, etc. appear in paragraphs. So it is very important to format
paragraphs properly. Some of  the formatting features are text alignment, tab stops,
paragraph indentation, line spacing, etc. The text delimited by the Enter key is
treated as a paragraph. In that sense, paragraph formatting is applicable to headings,
list of  items, etc.

The facilities provided by Writer to format paragraph is made available using the
command sequence Format → Paragraph... A dialog box as shown in Figure 2.12
will be opened. Different tabs are available in this dialog box for paragraph
formatting.

A. Paragraph alignment

Paragraph alignment refers to the
text layout within a paragraph with
respect to the document margins.
The boundaries of text get affected
by left and right margins and the
indentation for the paragraph.
There are two categories of text
alignment - horizontal alignment
and vertical alignment.

Horizontal alignment refers to the text alignment with respect to the left and right
margins. There are four types of  horizontal text alignment as specified below:

i. Align Left: This alignment aligns the selected text/paragraph aligned to the
left margin. This is the default alignment.

ii. Align Right: This alignment aligns the selected text/paragraph aligned to the
right margin.

iii. Centered: This alignment aligns the selected text/paragraph in the middle
between the left and right margins.

iv. Justified: In this alignment, the text is flushed to both the left and right margins,
thus the text/paragraph aligns evenly between left and right margins. The spacing
between the text or words will be automatically adjusted.

M=>?@B B=DE GHH?IJKNJO PGPNE Q?OR JNSNHHGEB N>?O?JI GJ> GPPUB

suitable character formatting features.
VWX YZ [\

Fig. 2.12: Paragraph formatting dialog box
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Vertical alignment refers to the alignment of  the selected text or object relative to
the current line or top and bottom margins of cells in a table. There are four types
of  vertical text alignments. These alignments have no effect on normal text appearing
in a document. It is applicable when the text is placed in a table cell. We will discuss
this in the next chapter. The various types of  vertical alignments are given below:

i. Top:  The text in the cell is aligned at the top.

ii. Bottom: The text in the cell is aligned at the bottom.

iii. Middle: The text in the cell is aligned at the centre with respect to upper and
lower margins of the cell in a table.

B. Paragraph indentation and line spacing

The indent refers to the distance between text boundaries and page margin. When
we start a new paragraph, we usually start typing by leaving some space from the
left margin. This space is indentation. There are mainly four types of indents as
shown in Figure 2.13.

Figure 2.14 shows the Indents & Spacing tab of  Paragraph dialog box where we
can specify values for the indents shown in Figure 2.13.

On the basis of the values given, indentation can also be classified as follows:

i. Positive Indent: Here the text is placed a little inward from the margins.

ii. Negative Indent: This type of indent allows the text to extend outward from
the margins.

iii. First line Indent: Here the very first line of the selected paragraph is placed a
little inward with respect to the rest of the text.

rstuvwx vy vwz{|vt{y }t ~���}~�

Smoking kills. Avoid smoking and
being smoked. Be healthy.

Smoking is injurious to health.
Smoking kills. Avoid smoking and
being smoked. Be healthy.

Smoking is injurious to health.
Smoking kills. Avoid smoking and being
smoked. Be healthy.

Smoking is injurious to heath. Smoking
kills. Avoid smoking and being
smoked. Be healthy.

Fig. 2.13: Four types of indents

�w��w} ���t|� }��}

or Left indent

�v|y} �vw� vw��w}

��wxvwx vw��w}

�w��w} ��}�| }��}

or Right indent
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iv. Hanging Indent: It makes the text other than the first line to move little inward
from the left margin.

When the indent applied is applicable to the left side of the page, it is called Before
text indent and the indent for the right side of the page is called After text indent.

Sufficient spacing can be given before and after a paragraph. Similarly, line spacing
within a paragraph can also be specified in the Indent & Spacing tab of  Paragraph
dialog box. Line spacing refers to the space between two lines of text in a paragraph.
Another way of interpretation is the total height of a line of text. The standard line
spacing are Single, 1.5 lines and Double. Refer to Figure 2.14 to see more options
for line spacing. The desired spacing in all these cases are specified in centimetres.

C. Drop Caps feature

In some documents, the first letter in a paragraph, usually the first paragraph, may
take the height of  two or more line. This is called Drop Caps feature. We can see
this feature in all chapters of this textbook. Have a look at the first page of any
chapter. To incorporate drop caps in a paragraph, proceed as follows:

• Place the cursor anywhere in the paragraph in which we utilise this facility.

• Open the Paragraph dialog box and select Drop Caps tab.

• Specify the number of characters to be dropped from the first and number of
lines it should span.

• Click OK button.

Fig. 2.14: Indents & Spacing tab of Paragraph dialog box
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Several formatting facilities are available for paragraph formatting. Considering
the scope of  the syllabus we confine our discussion only on these features.

£¤¤¥ ¦t Figure 2.15. Our document is now formatted according to
the settings as shown in Figure 2.14. Write down the procedure
adopted to make the document as shown in Figure 2.15.

§¨© ª« ¬­

Fig. 2.15: Document after applying character and paragraph formatting

2.8.4 Bullets and Numbering

Documents may contain list of  items. Two types of  lists are common - bulleted lists
and numbered lists. Bulleted lists are used when the list does not rquire any order
for the presentation of  its items. Bullet is a small graphic symbol, as shown in Figure
2.16, that appears in front of  each item in the list. For example, one’s hobbies can
be presented as a bulleted list. But some items may need to be presented in an
order. In such a case we use numbered list. For example, the districts in Kerala may
be presented with numbers 1 through 14 for Thiruvanathapuram to Kasaragode.

The procedure for making a list is as follows:

• Click the Edit menu and choose  Bullets and Numbering... option.

A window as shown in Figure 2.16 will be opened. We can select the Bullets or
Numbering type tab and choose the style of  bulleting or numbering. Figure
2.16 and 2.17 shows different types of  bulleting and numbering.

• Select the desired bullet/number and click OK  button.

• Go on with typing of each item.
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Whenever Enter key is pressed after presenting an item, a new bullet for the
next item will appear automatically. The window provides more tags for
colourful bullets, alignments, nesting (a list in which some or all items may
have another sub list), etc. Figure 2.18 and 2.19 shows a bulleted list and a
numbered list respectively. These lists belong to our article, which is now under
formatting process.

Note that a tool bar appears at the
bottom of the IDE window (just
above the Status bar) which facilitates
moving of items upwards or
downwards within the list,
renumbering, navigation through
sublevels, etc.

Fig. 2.16: Bullets tab of Bullets and
Numbering window

Fig. 2.17: Numbering type tab of
Bullets and Numbering window

Fig. 2.18: Bulleted list in the document

Fig. 2.19: Numbered list in the document

2.8.5  Page formatting

Page formatting involves the
setting of page layout and
design. That is we have to
specify the page size,
orientation, margins etc. In
Writer, page formatting is
controlled through Page Style

dialog box which is obtained
by selecting the Page option
from the Format menu. Figure 2.20 shows Page Style dialog box.
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A. Page Size (Paper Size) and Orientation

Writer offers standard page sizes for the documents like A3, A4, Letter, Legal etc.
To set the page size, click the Page tab of  Page Style dialog box which shows the
page formatting facilities as in Figure 2.20. Here we specify any of  the predefined
paper sizes available in the Format: box of  Paper format section. We can also select
the desired page-orientation by clicking on one of the desired Orientation buttons
- Portrait or Landscape.

Orientation refers to whether the text is to be printed length-wise or width-wise.
When the text is printed or typed length-wise, it is called Portrait Page Orientation
and when the text is printed or typed width-wise, it is called Landscape Page
Orientation. Figures 2.21(a) and 2.21(b) show the two types of orientation.

In the Page tab, we can specify the
margins (left, right, top and bottom)
and layout settings. Margins can be set
in two ways - using Ruler bars and using
Page Style dialog box

Using Ruler bars:  Move the mouse
over the area where the white ruler
changes to gray. When the cursor
becomes a double-ended arrow, click with the mouse and drag the margin indicator
to the desired location. Release the mouse when the margin is set.

Using Page Style dialog box: In the Page tab on the Page Style dialog box, either
directly specify the desired measurement for the margins in the corresponding boxes

Fig. 2.20: Page tab of Page Style dialog box

a. Portrait b. Landscape
Fig. 2.21: Page orientations
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or increment/decrement the default measurements using increment/decrement
buttons till we get the desired result (refer to Figure 2.20).

B. Header and Footer

Look at the top of  the pages of  our text book. We can see in print the words
“Computer Applications (Humanities) - XII” on every left pages. Similarly page
numbers can be seen at the bottom with a design. These text items are called header
and footer, respectively. These are commonly used in publications, books, project
reports etc. The common text appearing on the top of every page is the header and
at the bottom is the footer. Thus header or footer may be the page number, system
date, or a company logo. A header is printed in the top margin, and footer in
bottom margin. We can insert either header or footer or both in a document. Once
it is inserted in any page, it will be available in all pages of the document.

To add a header to a page, choose Header option from Insert menu and type the
text in the Header box. Similarly, to add footer to a page, choose Footer option
from the Insert menu. Usually we put page numbers in the footer. When the cursor
is in the footer section, the command sequence Insert →Field→ Page Number can
be used to get page number in the footer. Some other information like Total pages,
Author, Date, etc. can also made avaiable in the footer.

Alternatively, we can select Header or Footer tab in the Page Style dialog box (refer
to Figure 2.20). Here we have to select the Header on or Footer on textbox. Clicking
the Apply button followed by OK button brings the cursor at the header or footer area.

2.9 Printing the document

When we complete the preparation of  a document after editing and formatting, its
hard copy (print out) may be required. Usually the documents are to be submitted
to the concerned in the form of  hard copy. Now we can see how to take a print out.

We can use the command sequence File →Print, or the keyboard shortcut Ctrl+P,
or the Print button in the Standard toolbar. The Print dialog box will be opened
as shown in Figure 2.22. We can see the print preview of  a page in the left pane of
the window. Any page of  the document can be previewed by clicking the next or
previous button seen below the preview. Page numbers, number of  copies,  layout
setting, etc. can be given in this window. On clicking the OK button, the document
will be printed, if  the printer is ready.

Print preview of more than one page can be obtained using the the command
sequence File → Print Preview, or the keyboard shortcut Ctrl+Shift+O, or the Print

Preview button in the Standard toolbar. The Print Preview window is shown in
Figure 2.23.
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Fig. 2.22: Print dialog box

Know your progress

1. Name the four types of  text/paragraph alignments.

2. Which type of  indent shows the text present in the paragraph
little inward from the first line of text?

3. Common text appearing on top of all pages is ______.

4. Print Preview option is available in ______ menu.

5. Line spacing option is available in ______ menu.

Fig. 2.23: Print Preview window



51

àá âãtroduction to Word Processors

Let us conclude

A word processor is a package that helps to create attractive documents. It provides
editing and various kinds of  formatting facilities. It also provides features like word
wrapping, copy/cut and paste features, finding and replacing, etc. Character
formatting features include font setting, bold facing, italicizing, underlining, etc.
Different types of  alignments, indentations, line spacing, etc. are covered in paragraph
formatting. Towards the end, page formatting features and print setting are discussed.

Let us practice

1. Open a new Writer document and prepare the following letter to a parent
regarding PTA general body meeting.

From

Principal,

Your school name,

School address.

To

Parent's Name,

Home address.

Dear parent,

Sub: PTA General body meeting

It is decided to conduct the PTA general body meeting of this year  in our school
auditorium next Monday. You are requested to attend the meeting without fail.

Thanking you

Yours faithfully

Principal

Place

Date

a. Save the document as pta.odt

b. Make the From and To addresses bold and italic

c. Change the font face to Arial and size 12.

d. Under the text 'Sub: PTA General body meeting' .
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e. Copy your name from the 'From' address to the bottom of the document.

f. Align the text 'Thanking You' at the centre.

g. Right align 'Yours faithfully' and 'Principal' at the bottom.

h. Double space the matter of  the letter.

i. Save the letter again.

2. Prepare your own bio data. Apply the formatting features of  the word
processor to beautify it.

3. Prepare an application to the principal requesting for TC and Conduct
certificate.

ùúû üý þýýúýý

1. What is meant by 'word wrapping'?

2. How is a Writer document saved?

3. What is meant by indenting?

4. Differentiate between 'Undo' and 'Redo' features.

5. Write down the effect of  using the key combinations Ctrl+N and Ctrl+Q.

6. Differentiate between 'Save' and 'Save As' options.

7. Distinguish between Copy-Paste and Cut-Paste functions.

8. Differentiate between Print and Print Preview options.

9. Differentiate between Portrait and Landscape page orientation.

10. Write a few features of  a Word processing software.

11. Explain the various types of  text alignments in Writer.

12. Suppose you want to replace a particular text in the document with another
text. Write the steps to do that.

13. Differentiate between Left indent, First line indent and Hanging indent.

14. How do you change the margins of a document?

15. Write the steps to take a print out of  the document.

16. Briefly explain the IDE of  the word processor, LebreOffice Writer.

17. Explain the various formatting features of  Writer.


